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From the President
—Barbara Blowes

—Barbara Blowes, President

like this time of the year seeing all the movement in the
plants and the warmer weather; its nice taking Honey out
for her walks.I

I hope you have checked and updated your devices if you
are able to do this. I haven't had a lot of time to play, but
Safari has a lot of differences. Honestly, I do wish it wouldn’t
happen so quickly and there was another update today for
the iPad OS15.0.1. I must admit the camera on my iPhone
11+ takes super photos especially when I want to
photograph my mini dolls. I do this as I can then see that my
painting is ok on them.
How many of you are fed up like me having to wear a mask
fogging up your glasses; it's an utter humbug. I avoid going
out shopping till I really have to. Hopefully, it won’t go on for
ever; but I think we are going to be like this unfortunately for
ages.
My watch has a few new features with the latest update;
fun seeing what they all are.

I asked Siri to set an alarm for me tonight and even she has
a new vocabulary, she even said Good Evening to me! New
technology is very interesting. 
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The Learning Centre

Morning Sessions
Monday, Wednesday and Friday

10.00 am to 12 noon

The SeniorNet Mac Apple NEWS is distributed

bimonthly on 10th April, June, August, October,

December and February. You will be kept updated on

important matters with a Mini Newsletter by email

every week, in between times.

If you need to bring in your computer please ring:

03 365 1979

and leave a message

Items that can be solved quickly will be $5 but

problems requiring significant time will attract up

to $20 workshop charge.

Afternoon Session
Wednesday, 1.00 pm to 3.00 pm

Pop in and have a cuppa in the learning centre.

You can get answers to computer problems, ask

questions and get advice.

SeniorNet Mac Inc. PO Box 475

Christchurch 8140

41 Essex Street, Christchurch

Web: http://seniormac.org.nz/

SeniorNet Mac Executive and Committee

John Hampton Patron

Committee Members for 2021/22 are:

Barbara Blowes President president@seniormac.org.nz

Charlie Millar Vice President vice.president@seniormac.org.nz

Elizabeth Chesney Secretary /Treasurer secretary@seniormac.org.nz

Brian Henderson Trustee
Erika White Events Manager events@seniormac.org.nz

Barbara Robinson Customer Services services@seniormac.org.nz

Bruce Perkins Memberships memberships@seniormac.org.nz

Wendy Perkins Social/Raffle ssocial@seniormac.org.nz

Robin Harrington Trustee/Fundraising funds@seniormac.org.nz

Grace Adams Bookings bookings@seniormac.org.nz

Ross Clendon Legal Advisor
Ross Beach Editor editor@seniormac.org.nz
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From the Editor
—Ross Beach

—Ross Beach, Editor

hen I designed the cover of the February/March Apple NEWS it was

titled“2021 A New Dawn and the hope for a brighter better future”.

Unfortunately that hasn’t eventuated. There is an old saying “goneW
tohell in a handcart” unfortunately at times this year I have felt that is an apt

description of the world this year—Covid and now Delta, Afganistan, World

Climate disasters; Flooding, Eruptions, Earthquakes etc. Let’s hope that things

improve dramatically in the foreseeable future. Though today is not a

particularly nice day—cold and wet, it is nice to see in our garden the

Japanese weeping cherry Falling Snow in blossom and the Japanese Maples

coming into leaf. Apple NEWS this time is 48 pages and includes the new

Apple products that were announced in mid September, they are iPhone 13

and iPhone 13 Pro, Apple Watch Series 7, iPad Mini and iPad.There is a

Review of the iPad Mini, an Article on Online Security, an Article on a copy of

Apple II Manual selling for $800.000. Cookin’ with Apple, Tips from across the

Ditch (Pam Doughty), Brian says…How2 (Brian Henderson) and the Guest

Speakers for October and November. Please take care and scan, wear a mask

— and you have my sympathy if you have the same mask wearing problems

that I have, Spectacles fogging up, Hearing Aids becoming tangled in the

elastic bands around your ears. Fortunately my vision is reasonable without

having to wear my spectacles except for driving the car when I can then have

my mask down. So until next time—Zàijiàn 
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IMPORTANT
INTERNET BANKING

Our Direct banking number is 020816-0376043-00
PLEASE when paying monies to SeniorNet Mac, include as

reference either your Name or Membership Card number.

We are receiving credits from time to time from unknown

members. We have no way of telling who they are from.

Your Membership Number is a unique number and has 4 digits

beginning with the figure 4

Elizabeth Chesney
Treasurer@seniormac.org.nz

Apple User Group
Canterbury Apple Users

is a subgroup of Christchurch SeniorNet Mac Inc. and
meets on the last Wednesday of each month at

7.30 - 9.30pm in the SeniorNet Mac Rooms,

41 Essex Street, Christchurch.

Aheated roomwith all conveniences, tea/coffee and bikkies.
FREE to SNM members. General public $4.00

Meetings will discuss users' problems and review recent

announcements and news relating to Apple products. All welcome. 
�

DeadlineDEADLINE SeniorNet Mac Inc.
Christchurch Learning Centre
Our Privacy Policy

• Wecollect information for lawful purposes sowe
cancommunicatewith ourmembers.Wecollect
information sowecanensureweareproviding you
with relevant courses, newsabout technologyand
invitations toevents.

• Wealsoprovidedemographic information toour
funders, sponsorsand togovernment agenciesbut
this informationdoesnot includepersonal
identification.Whileweappreciate this
demographic information, it is not compulsory to
provide it.

• Wemayshare your contact informationwith our
national body, TheFederationofNewZealand
SeniorNetSocieties Inc, so that in theevent of the
closureof our LearningCentre, for any reason,we
cankeep in touch.

• Wewillbehappytoshowyouwhatever information
wehaveaboutyouonourmembership filesandwe
willendeavour tokeepthat informationuptodateat
yourrequest.

Our Sponsors

Also in association with:

The Federation of NZ SeniorNet Societies

Deadline for December/January Apple NEWS

28th November 2021

Please have your copy for the next Apple NEWS to me
by the above date.

Copy can be either typed straight into an email, as a
Word file or as Rich Text Format.

Digital images need to be at least 220dpi or higher
(72dpi will not reproduce well)

Please no hard returns except at the end of a



Page 7Helping Seniors with Apple Technology http://seniormac.org.nz

SeniorNet Mac

41 Essex Street

We can
HELP

email:

bookings@seniormac.org.nz

Need

tuition?

Need

to upgrade

your Apple

Device?

Want

to know more

about

Apple TV?

Need

help with

Online

Banking?

How to use

Skype and

Face Time?

New to

Apple Devices

and

Programmes?

How to

stay safe and

not be

Scammed?

What is

iCloud and

Dropbox?
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Cookin’ with
TARTA DE MANZANA (Spanish Apple Tart)

INGREDIENTS

1 sheet puff pastry, t
hawed

4 Granny Smith Appl
es

1 Lemon, juice only

1 teaspoon ground c
innamon

Apricot Jam, for gl
aze

DIRECTIONS

• Preheat oven to 20
0ºC

• Peel, core and slic
e apples.

• Roll out puff pastry
on a floured surfac

e and place in a 9-
inch pie dish.

• Trim any pastry that han
gs over the edges.

• Arrange apple slic
es in pastry shell; p

our lemon juice ov
er apples.

• Place tart in its pan
on a baking tray an

d place on middle o
f oven rack.

• Bake for about 30 m
inutes, covering pa

stry edges with foi
l if browning too qu

ickly.

• Remove from oven

• Spread softened a
pricot jam over apples and sp

rinkle over cinnam
on.

• Cool for 10 minutes

• Serve with whippe
d cream and/or yogurt.

https://www.food.com/about/puff-pastry-527
https://www.food.com/about/puff-pastry-527
https://www.food.com/about/puff-pastry-527
https://www.food.com/about/puff-pastry-527
https://www.food.com/about/cinnamon-324
https://www.food.com/about/cinnamon-324
https://www.food.com/about/cinnamon-324
https://www.food.com/about/cinnamon-324
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Online Security

Newshub !4/9/2021

Apple users urged to update software

immediately after new iMessage

vulnerability found

Mike Kilpatrick

Photo credit: Getty Images

All Apple users are being told to ensure their software is

up to date after a cyber surveillance company based in

Israel developed a tool to break into Apple iPhones.

The never-before-seen technique has been in use since

February, internet security watchdog group Citizen Lab has said.

The discovery is important because of the critical nature of the

vulnerability, which requires no user interaction and affects all

versions of Apple's iOS, OSX, and watchOS, except for those

updated today.

The vulnerability developed by the Israeli firm, named NSO

Group, defeats security systems designed by Apple in recent

years.

Apple said it fixed the vulnerability in the latest software

update, confirming Citizen Lab's finding.

An Apple spokesperson declined to comment regarding whether

the hacking technique came from NSO Group.

An NSO spokesperson did not immediately respond to a request

for comment.

Citizen Lab said it found the malware on the phone of an

unnamed Saudi activist and that the phone had been infected

with spyware in February. It is unknown how many other users

may have been infected.

The intended targets would not have to click on anything for the

attack to work. Researchers said they did not believe there

would be any visible indication that a hack had occurred.

The vulnerability lies in how iMessage automatically renders

images. iMessage has been repeatedly targeted by NSO and

other cyber arms dealers, prompting Apple to update its

architecture. But that upgrade has not fully protected the

system.

"Popular chat apps are at risk of becoming the soft underbelly

of device security. Securing them should be top priority," said

Citizen Lab researcher John Scott-Railton.

The US Cybersecurity and Infrastructure Security Agency had

no immediate comment.

Citizen Lab said multiple details in the malware overlapped

with prior attacks by NSO, including some that were never

publicly reported.

One process within the hack's code was named "setframed,"

the same name given in a 2020 infection of a device used by a

journalists at Al Jazeera, the researchers found.

"The security of devices is increasingly challenged by

attackers," said Citizen Lab researcher Bill Marczak.

A record number of previously unknown attack methods, which

can be sold for US$1 million or more, have been revealed this

year. The attacks are labeled "zero-day" because software

companies had zero days' notice of the problem.

Along with a surge in ransomware attacks against critical

infrastructure, the explosion in such attacks has stoked a new

focus on cybersecurity in the White House as well as renewed

calls for regulation and international agreements to rein in

malicious hacking.

As previously reported, the FBI has been investigating NSO,

and Israel has set up a senior inter-ministerial team to assess

allegations that its spyware has been abused on a global

scale. 

The following two articles appeared on line a month apart.
—Editor

RNZ 14/08/2021

Kiwis urged to take notice when Apple

texts about passwords being

compromised

Photo credit: Getty Images

Take these warnings seriously if you want to be confident your

online information is safe, says Auckland cybersecurity expert

Daniel Watson.

Treat pop-up warnings about your internet security as

suspicious but don't disregard warnings from your own service

providers, he told RNZ.

https://www.newshub.co.nz/home/author-pages/mike-kilpatrick.html
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These alerts are a legitimate warning that your online

credentials may have been stolen, Watson says.

"Apple is going 'Look, if you're using a password that is already

well known then you shouldn't be using it, you need to change

it."

Kiwis tend to use the same passwords over and over again and

be logged into dozens of websites at once, Watson says.

"Not every website has great levels of password security

themselves so when somebody does get into them they can

crack it open and they sell the database on the dark web, make

a bit of money from it, or use it for further attacks themselves."

Watson recommends going with a 'pass phrase' rather than a

password as they're easier to remember and harder to crack.

"A password like 'We all love Jacinda Ardern' is quite a long

set of characters which can be hard for anybody to guess but

it's really easy for you to remember."

The Chrome web browser has a password management tool

that's safe enough for individual users, but if you're running a

business, investing in company-wide password management

software is a good idea and quite affordable, Watson says.

It's also handy, really handy when people leave, Watson says.

"You'll reset [the former employee's] work server password but

there's a whole bunch of other websites that they've logged on

to as part of their day to day business which you probably also

need to go out there and disable.

"If you're running a company you don't want people saving their

work passwords in a tool which is going to walk out of the

organisation attached to their Gmail account." 
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Apple's New products
14 September 2021

A dramatically more powerful camera system.
A display so responsive, every interaction feels new

again. A lightning-fast new chip. Exceptional
durability. And a huge leap in battery life.

iPhone 13

Available starting 24 October 2021
From NZ$1,799
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iPhone 13
Pro Max

6.7″

iPhone 13
Pro

6.1″

Super Retina XDR display with ProMotion

Available in these colours

SilverSiera Blue Gold Graphite

Surgical-grade stainless steel
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Ceramic Shield,
tougher than any
smartphone glass

Industry-leading
IP68 water
resistance2

Our Pro camera system gets its
biggest upgrade ever. With next-level
hardware that captures so much more
detail. Superintelligent software for

new photo and filmmaking
techniques. And a mind-blowingly
fast chip that makes it all possible.
It’ll change the way you shoot.

Macro
photography
comes to
iPhone.

With its redesigned lens and powerful autofocus
system, the new Ultra Wide camera can focus at just
2 centimetres — making even the smallest details
seem epic. Transform a leaf into abstract art. Capture
a caterpillar’s fuzz. Magnify a dewdrop. The beauty
of tiny awaits.

Macro video, anyone?
Macro stills are just the beginning.
You can also shoot macro videos —
including slow motion and time-lapse.
Prepare to be mesmerised.

Bring on the night.
iPhone 13 Pro was made for
low light. The Wide camera
adds a wider aperture and
our largest sensor yet —
and it leverages the LiDAR
Scanner for Night mode
portraits. Ultra Wide gets a
wider aperture, a faster
sensor and all-new
autofocus. And Telephoto
now has Night mode.

The Wide camera captures up to
2.2x more light

for better photos and videos
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The Ultra Wide camera captures
92%more light
for better photos and videos

Night mode now on every camera
Sharper, more detailed photos and
videos in any light

More
zoom?
Boom.

The new Telephoto camera features a
77-millimetre focal length and 3x
optical zoom — great for classic
portraiture or shooting clearer photos
and videos from far away. For closer
subjects, try Portrait mode, where
you can dial in the bokeh and
experiment with studio-quality
lighting effects.
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3x optical zoom on Telephoto
for closer close-ups.
6x optical zoom range across the
system
for more framing options than ever.

Customise your camera to

lock in your look.

Introducing Photo graphic Styles.
Photographic Styles apply your
preferred Tone and Warmth settings
to your photos. But unlike filters, they
keep things like skies and skin tones
natural. Choose an Apple-designed
preset — Vibrant, Rich Contrast,
Warm or Cool — and if you want,
fine-tune it even further. Set your
style once to get the look you love
every time.

Tone
Increase for
brighter,
more vivid
colours.
Decrease for
stronger
shadows and
contrast.

Our advanced
image
pipeline
renders your
customised
style
in real time.
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Apple Watch Series 7
Available later this year

The largest, most advanced Always‑On Retina display.
The most durable Apple Watch ever. Breakthrough

health innovations. Up to 33% faster charging.

Tap. Type. Swipe.
Easy on the eyes. Easy on the fingers.

Across the system, buttons have been

redesigned to take advantage of the larger

display. So using apps like Calculator,

Stopwatch and Timer is easier than

ever.Across the system, buttons have been

redesigned to take advantage of the larger

display. So using apps like Calculator,

Stopwatch and Timer is easier than ever.

An Apple Watch first — a new QWERTY

keyboard lets you tap or slide from letter

to letter with QuickPath. It uses

machine learning to predict the word

you’re typing.

Use Scribble to write letters on your

screen and compose a text message

or email. The larger display makes it

faster and easier for all finger types.
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Breaking news: Series 7 is the
most durable Apple Watch ever
built.
Fundamental design changes were needed to achieve the vision

of the larger Always-On Retina display. These same innovations

also helped make the most crack-resistant front crystal yet.

Crack-Resistant
Our strongest front crystal ever.
Dust-Resistant
IP6X certification.1
Water-Resistant
Swim-proof with WR50 water resistance.

Tougher around the clock.

50 per cent thicker front crystal. The
front crystal is over twice as thick at
its tallest point compared to
Apple Watch Series 6, adding
strength and durability.
Robust geometry. The front crystal
has been redesigned with a flat base,
creating a sturdier shape more
resistant to cracks.
OLED display. The touch sensor has
been integrated onto the OLED panel,
creating one unified component and
reducing display thickness
and borders

The future of health. On full display.
Measure your blood oxygen level with a
revolutionary sensor and app. Take an
ECG at any time, anywhere. Check your
heart rate. Along with other innovations
like mindfulness and sleep tracking to
keep you healthy from head to toe.
Series 7 puts more health insights
in sight.

Measure your blood oxygen. It’s a
breathtaking innovation. Your blood
oxygen level is a key indicator of your
overall wellness. It can help you
understand how well your body is
absorbing oxygen, and the amount of
oxygen delivered to your body. The
remarkable sensor and app in
Apple Watch Series 7 allow you to
take on-demand readings of your
blood oxygen as well as background
readings, day and night.

Take an ECG at any time. With the
ECG app, Apple Watch Series 7 is
capable of generating an ECG similar
to a single-lead electrocardiogram.
It’s a momentous achievement for a
wearable device that can provide
critical data for doctors and peace of
mind for you.

Your finger can tell you a lot about
your heart. Electrodes built into the
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Digital Crown and the back crystal
work together with the ECG app to
read your heart’s electrical signals.
Simply touch the Digital Crown to
generate an ECG waveform in just
30 seconds. The ECG app can
indicate whether your heart rhythm
shows signs of atrial fibrillation — a
serious form of irregular heart rhythm
— or sinus rhythm, which means your
heart is beating in a normal pattern.

Dream machine. The Sleep app
doesn’t just keep track of your sleep.
It also helps you create a schedule
and a bedtime routine so you can
meet your sleep goals. It even tracks
your respiratory rate while you’re
sleeping. How refreshing.

Charges in no time. The entire
charging system for Apple Watch
Series 7 has been rethought to get
you up and running faster than ever.
With an updated charging
architecture and fast-charging USB-C
cable, it takes about 45 minutes to go
from 0 to 80 per cent charge.

Up to

33%
faster charging than Series 6

8mins
provides 8 hours of sleep tracking

Stay centred. Move ahead. Taking a
moment throughout the day to pause
and breathe can reduce stress.
The new Reflect feature in the
Mindfulness app helps you set an
intention and centre yourself with a
beautiful animation. And new audio
and video guided meditations in
Apple Fitness+ focus on improving
your overall wellbeing with specific
themes such as calm, gratitude
or kindness.
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Tap into dozens of workouts. Track all
the ways you move. Advance your
goals with Apple Fitness+.
Apple Watch Series 7 gives it
everything. And thanks to the larger
display, you’ll see all your progress
and metrics more quickly and clearly,
in and out of the water. Let’s go —
there’s more in there.

Massively motivating.

Fitness that revolves around you.
Squat, serve, stride, you name it —
Apple Watch has a workout for it. And
now, there are Tai Chi and Pilates
workouts to get your endorphins
going. The starting line is on your
wrist.

Cycling finds a whole new gear.
Apple Watch now automatically
detects when you begin pedalling and
reminds you to start a workout. Fall
detection, now optimised for cycling

and other workouts, can call
emergency services if you take a spill.
And to help you keep your eyes on
the road, a voice feedback feature
announces workout milestones, like
speed, distance and more. For e-
bikes, an improved algorithm more
accurately calculates calories.

H2O. You’re good to go. Apple Watch
is water-resistant to 50 metres.
So whether you’re in open water or
tracking your splits and sets at the
pool, you’re covered

Motivation from start
to finish line.

Activity Rings.
Move, Exercise and

Stand. Three rings

that show all the

ways you move

throughout the day.

Activity Sharing.
Share your Activity

rings with friends and

family to encourage

each other.

Competitions.
Invite friends to

compete in a

seven-day Activity

challenge.

Music, Podcasts
and Audiobooks.
With Apple Music, you’ve

got 75 million tracks of

musical motivation on

your wrist. There are also

podcasts and audiobooks

to help you lose calories

and yourself along

the way.
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The first fitness service powered by Apple Watch.
Apple Fitness+ is a different kind of fitness experience.
There are new workouts every week, from five to 45
minutes. 11 workout types, including HIIT, Strength,
Pilates and Yoga. Guided meditations to help you focus on
your overall wellbeing. And personal metrics from
Apple Watch synced to your iPhone, iPad and Apple TV.
Get three months on us when you buy an eligible
Apple Watch.

Everything you need.
Everywhere you go.
Just put on your Apple Watch and take off. Series 7 keeps
all the things you care about front and centre with its
larger screen. And with available cellular, you can stay
connected to your family, friends, music, notifications,
photos and more — even when you don’t have your
phone.

Freedom calls. Take a call from the park.
Text a smiley face to your friends stuck in the
office. Apple Watch with cellular gives you all
the right connections. Feel free to leave your
phone at home.

Wallet keeps it all in one place. Start your
car. Board your plane. Pay for just about
anything. And that’s only the start. With the
Wallet app, you’ve got everything important
in one location. Perfect when you’re all over
the place.

Siri. An answer for life’s big questions.
Where’s the closest service station? What’s
that song? Ask away. Siri can even translate
foreign languages in real time.
That’s fantástico.

Maps. Your guiding hand. Whether you’re
walking, driving or catching public transport,
Maps makes it easy every step of the way.
Gentle taps from the Taptic Engine let you
know when it’s time to turn left or right, so
you don’t have to look at your watch.

Apps specifically
designed to
do everything.
With access to thousands of apps from the
App Store right there on your wrist,
Apple Watch is the perfect personal device for
whatever you love to do. Surfing, photography,
astronomy, you name it. Just download the
app straight to your Apple Watch and you’ve
got everything you need close at hand.
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Available starting 24.9

Powerful A15 Bionic chip. New
all‑screen design. Superfast

5G.
Ultra Wide front camera with
Centre Stage. Now in four

gorgeous colours.

The magic of iPad.
In the palm of
your hand.
Mega power.
Mini sized.
Apple Pencil attaches magnetically
to the side of iPad mini, so it’s always
with you and ready for a spur-of-the-
moment sketch or spontaneous
brainstorming session.

New all‑screen design. Powerful A15
Bionic chip. Superfast 5G.
Support for Apple Pencil.
Now in four gorgeous colours.
A device unlike any other.

Touch ID is integrated into the top button for
fast, easy and secure authentication. Use
your fingerprint to unlock your iPad or
quickly and securely make a payment.

Small is the
new Powerful
The new A15 Bionic chip makes iPad mini
just as powerful as it is portable. Whether
you’re tearing through your inbox or editing
photos with Photoshop, it has the power to
do everything. Use advanced apps, capture
brilliant content and bring your creative
projects to life, anywhere.
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Delivering up to 40 per cent faster CPU
performance and, with the Apple
Neural Engine, up to 2x faster machine
learning. So you can fly through your
workday, studio session and more.
6-core CPU
Up to 40% faster performance

And with up to 80 per cent faster graphics,
iPad mini lets you immerse yourself in
whatever you do. Use realistic brushes to
create a watercolour, experience unreal AR
and play graphics-intensive games.
5-core GPU
Up to 80% faster graphics

iPad mini has all-day battery life, so it’s
always ready for any task or project.3 Keep
working, creating and playing — without
missing a beat.

Upload.
On the road.

With ultrafast connections and the new 5G
capabilities of iPad mini, you can get on the
fastest available wireless networks when
you need to download files, stream movies
and check in with friends on the go
5G connectivity
Superfast downloads and high-quality
streaming
Wi-Fi 6
Fastest Wi-Fi available

Fast wireless connections are critical to
getting things done. With Wi‑Fi 6 now on
iPad mini, rest assured that you have the
fastest Wi‑Fi available.
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Connect and charge with the versatile USB-C
port. Plug in accessories to make music, run
your business and more

The Wide camera on the back of iPad mini
features a 12MP sensor with Focus Pixels and
a large aperture to capture sharp, vivid
photos. And the new ISP in the A15 Bionic
chip enables Smart HDR 3, for capturing even
higher-quality images.
12MP
Wide back camera
True Tone flash
Improves photos in low light

The back camera also has a True Tone flash,
so you can take great photos in any light, or
scan documents and then mark them up.
And iPad mini can now record in 4K, making
it your mobile movie studio.

Smart Folio. Everyday
Apple Pencil.

iPad mini now supports the second-
generation Apple Pencil.2 It attaches
magnetically and charges wirelessly, so it’s
always with you when inspiration strikes.
And you can double-tap the barrel to quickly
switch between tools like a highlighter and
an eraser.
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With Apple Pencil, iPad mini transforms into
a mobile sketchbook and the worldʼs best
note-taking device. You can write, draw and
mark up with ease.

A new set of slim Smart Folio covers in
beautiful colours complement the new
iPad mini finishes. You can protect iPad mini
and even prop it up in a flash.

Work wonders
with ease.
iPad mini is powered by iPadOS, enabling you
to do so much, so easily. Get things done with
the simplicity of Multi-Touch gestures, use
multiple apps at once, and write in any text
field with Scribble.

And with new features in iPadOS 15, iPad
mini is even more versatile. You can jot down
your thoughts with Quick Note, translate a
conversation with Translate, and connect
withfriends and family using SharePlay.
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From NZ$569

Powerful. Easy to use. Versatile. The new iPad is
designed for all the things you love to do.

Available starting 24.9
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The A13 Bionic chip makes
everything more responsive,
from messaging to web
browsing to using multiple
apps at once

Up to 20 per cent faster GPU
gives you the graphics
performance you need.
Perfect for playing immersive
games and more.
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A more powerful
Neural Engine drives machine
learning–based features like
Live Text in iPadOS 15.

The A13 Bionic chip
effortlessly powers advanced
apps like Procreate, with its
ultrarealistic watercolours.

With all-day battery life, iPad
is ready to work or play for as
long as you need it.
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With incredible detail and vivid
colours, the 10.2-inch Retina
display is perfect for watching
movies, working on a project or
drawing your next masterpiece.

True Tone adjusts the display to the
colour temperature of the room to
make viewing comfortable in any
light.

Centre Stage makes video calls more engaging by automatically adjusting
to keep you centred in the frame.
And it lets you create fun videos you can post to popular social apps.

In addition to Centre Stage, the 12MP Ultra Wide
front camera brings a huge boost in image
quality for even better selfies and group shots.

The 8MP Wide camera on the back of iPad
captures sharp,vivid images and video.

The versatile back camera also lets you scan
documents and experience immersive AR apps.
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Download files, stream movies, collaborate with colleagues and
upload content from just about anywhere.

Fast Wi-Fi lets you stay connected at home, work, school or wherever you
go with iPad.

With Gigabit-class LTE, you
can connect even when you
canʼt access Wi-Fi.
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Using Apple Pencil is as natural as
putting pen to paper, but with
capabilities that make handwriting as
powerful as typed text.

Attach a thin and light Smart Keyboard
for comfortable typing — perfect for
writing your novel or crafting your
business plan.

Take unforgettable notes, create a
work of art, mark up screenshots and
much more.

The Smart Keyboard folds up into a
slim, lightweight cover for portable
protection.
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Designed for the large Multi-Touch
display, iPadOS is powerful and easy
to use.
iPadOS 15 pushes the capabilities of
iPad further with more discoverable
multitasking, new ways to find and
organise information, and enhanced
note-taking.
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iPad comes with powerful Apple
designed apps like Photos, Maps,
Messages, Mail and Safari. And with
over a million apps on the App Store
designed just for iPad, youʼll find the
right app for anything you want to do.
Make a beat, get a workout in or join a
battle royale with friends.
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Technology is most powerful when everyone
can use it. Thatʼs why iPad comes with
accessibility features that support vision,
hearing, mobility and cognitive needs. Like
sign language prominence in FaceTime,
which can detect when a participant is using
sign language and make the person
prominent in a Group FaceTime call.

Like every Apple product, iPad was designed with your privacy and security in mind.
Itʼs not always easy.
But thatʼs the kind of innovation we believe in.
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Review

Newshub 24/9/2

Review: Apple's iPad Mini delivers

style, functionality and good looks in a

tiny package

Up until this week I had never seriously considered the

iPad Mini as a gadget I needed to own. They were barely

even on my radar.

I have various computers, ebook readers, a large-screened

phone and an iPad Pro that allows me to write on the move -

what would I need with another gadget, besides more space on

my bedside table?

And yet the announcement last week had me intrigued. It's

clear from the upgrades the Mini is something Apple wants to

be taken seriously, so maybe it was time for me to reconsider

my position.

So what is the iPad Mini? Previously I had thought of it as just

a very limited tiny iPad or an extremely large iPhone. But could

it be more?

It had taken quite a while to convince the sceptic in me to fully

embrace touchscreen technology in devices other than phones,

so maybe the upgraded Mini could do the same if I wiped away

my preconceived notions.

I've been using the iPad Mini for a few days now and here are my

thoughts.

Mike Kilpatrick

Photo credit: Newshub

Photo credit: Newshub

The good

Despite knowing in advance the Mini has an 8.3-inch Liquid

Retina display, nothing could prepare me for just how small it

feels when you take it out of the packaging for the first time.

All those doubts were coming flooding back. I just couldn't

imagine how I could use such a tiny tablet as I used my iPad

Pro.

And then, after about an hour, it clicked - I'm not supposed to

use it in the same way. They're not the same device and they

have very different uses.

With that flash of inspiration - about five years too late - I was

able to thoroughly enjoy using the sixth-generation of this

device, the first upgrade it's had since the 2019 model.

Touch ID has been moved to the power button on the top of

Mini, leaving an unadulterated screen to wow the eyes. And

does it!

Thanks to Auckland's weather, I was able to test it's use it in

bright sunshine and dark grey skies within a few minutes.

The 500 nits peak brightness, anti-reflective screen and True

Tone display meant the experience never wavered and the

2266x1488 resolution was just right for my aging eyesight.

Streaming Coco on Disney+ and The Office on Netflix looked as

stunning as I hoped it would - even if the black bars on top and

bottom make the viewing area smaller than ideal. It's better to

have the right aspect ratio than missing details, right?

It's the little things that really impressed me, though, from the

dual speakers on both sides of the Mini so you get great sound

in landscape mode, to asking me to set up a second finger to be

able to unlock it.

Photo credit: Newshub / Disney Pixar

I couldn't work out why I was being asked that until I was lying

in bed and realised I used that secondary finger all the time in

landscape mode. It saves me just a few seconds but it just

makes the whole process seem more natural.

Of course, if it had FaceID then that wouldn't be necessary, but

more on that soon…

The processor in the Mini is the same as in the new iPhone 13

range, the A15 Bionic, with a 6-core CPU and 5-core GPU here

to make this as ridiculously fast as you would expect.

https://www.newshub.co.nz/home/technology/2021/09/new-ipads-apple-watch-series-7-unveiled.html
https://www.newshub.co.nz/home/technology/2021/06/review-apple-s-ipad-pro-stuns-with-its-speed-and-beauty-but-is-it-worth-the-hefty-price.html
https://www.newshub.co.nz/home/technology/2021/06/review-apple-s-ipad-pro-stuns-with-its-speed-and-beauty-but-is-it-worth-the-hefty-price.html
https://www.newshub.co.nz/home/author-pages/mike-kilpatrick.html
https://www.newshub.co.nz/home/technology/2021/09/iphone-13-range-releasing-in-new-zealand-on-september-24.html
https://www.newshub.co.nz/home/technology/2021/09/iphone-13-range-releasing-in-new-zealand-on-september-24.html
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I downloaded and played Divinity: Original Sin 2, released on

the iPad earlier this year and designed for high-end versions

only. It worked flawlessly here, with zero lagging issues, stutter

or any other issues - besides my complete lack of gaming

ability.

It even added a whole new dimension to games I've previously

played on both my iPhone and iPad.

Layton's Mystery Journey and Pinball Party are so much better

on the Mini than on the other two devices. The screen really is

the perfect size for gaming on the go.

I found myself losing sight of the pinball on my phone so many

times, to the point of frustration. And bigger devices are just too

unwieldy to be used for handheld games like that.

It's not a coincidence I started setting all my best scores on

those classic Williams Pinball machines in the last few days.

Last, but certainly not least, it took just a few minutes late at

night to realise I could replace the two eReaders at the side of

my bed with this.

Photo credit: Newshub

Not only do I get access to my already existing Kobo and Kindle

libraries on the iPad, I can also read my graphic novel collection

in full colour and access all of Auckland Libraries' eBook

collections though the Libby app.

Bigger tablets, I find, are just a wee bit too big and heavy to

use in bed. I've fallen asleep with one previously, and it ended

up smashing me on the nose.

The weight is perfect, the apps and screen combine to

maximise your reading ability while minimising the impact on

your eyes and I started re-reading Y: The Last Man because it

looked so great and it was so convenient.

And with all day battery life, there was no worry I was going to

run out of juice before finding out what Yorick and his monkey

were getting up to next.

Throw in USB-C connectivity rather than Lightning, the easy to

use, charge and store Apple Pencil 2 and decent, if not game

changing, 12MP cameras front and rear then you've got a pretty

damned good package.

The bad

There's really not much to dislike about the iPad Mini, not a

sentence I was expecting to write.

Photo credit: Newshub

It was only when forced to use a button to unlock the Mini did I

realise just how used to FaceID I've become. Even in pure

darkness at 3am I know I can pick up my phone and it'll unlock

straight away.

Whether it's cost-related or due to some issues with space, I

really do miss the functionality more than I thought. The finger

sensor is great, and works as expected, it's just that wee bit

slower because it's not automatic. Maybe one for the next

generation.

I was also ready to lambast Apple for the lack of type cover,

until I realised there really was no use for one. Any keyboard

would either stick out or be too small to be useful. And, frankly,

if you're looking for a device for writing on, it's not this one.

I was easily able to add an external Bluetooth keyboard to test

it out, and it worked fine. But for short typewritten notes, I

found two-finger typing on the on-screen keyboard more than

adequate. If I needed to write more, I'd simply switch devices.

Even with my aging eyesight, there were only a couple of

occasions where the diminutive screen proved to be a little bit

of an issue - and that's when I was multitasking.

With two different apps splitting the screen it just felt there

wasn't quite enough room for both. It wasn't a terrible

experience, it's just one I can't see myself using that much. To

be fair, I haven't used it much on the iPad Pro either.

The verdict

I can't recall the last time a device went so quickly from

'hmmm, I'm not sure about this' to 'OMG, I need this NOW'. If I

had to guess it was either the first generation Samsung Galaxy

S phone I ended up parallel importing or the first iPad Touch.

Regardless, in just a few short days I find it hard to imagine not

having this beautiful wee device with me.



Page 36Helping Seniors with Apple Technology http://seniormac.org.nz

Photo credit: Newshub

Not only did it prove useful for note taking, watching movies

and embracing my inner Picasso, it immediately replaced

devices I previously used for gaming and reading.

I've loved eBook readers since they first arrived on our shores,

and recently I was seriously considering paying NZ$699 for one

with only reading/note taking capabilities.

The basic Wi-Fi iPad Mini comes in at $849, with the Apple Pencil

costing NZ$239 and the Smart Folio case NZ$109 on top if you

want the full experience. If you want a cellular connection included

then those models start at NZ$1,099.

Even at those prices, the additional functionality offered means no

more stand alone book readers for me.

The Mini is easy to hold one-handed, whether you're lazing on the

couch or lying in bed - both of which I am incredibly proficient at -

and, without wanting to anthropomorphise it too much, it's just so

damned cute.

I can't wait for the current lockdown to be over so I can start

travelling again, with my new best friend in my pocket. Okay, bag -

it's not quite that small.

There are too many devices that are jacks of all trades and masters

of none. It's never been more of a lie when applied to this device.

So what is the iPad Mini? Simply it's the master of many.

Newshub was supplied an iPad Mini, Apple Pencil 2 and Smart
Folio case for this review. 

RANDOM THOUGHTS DURING LOCKDOWN

Day 27 at home
and the dog is looking at
me like, "See, this is
why I chew the

furniture".

Remember when
you were little and all your
underwear had the days of
the week on them. Those

would be helpful
right now.

If these last few weeks
have taught us anything
—it's that stupidity travels

faster than any virus
on the planet .

Why is it that there
is always one idiot who will

spoil it for everyone
else.

SILLY YOU!
You thought dogs were hard

to train. Just look at all
the humans who can't

sit and stay.

Remember all those
times when you wished the
weekend would last forever.

Well, Wish Granted.
Happy Now?

https://www.newshub.co.nz/home/technology/2021/06/review-kobo-elevates-ebook-reader-range-with-expensive-elipsa-bundle.html
https://www.newshub.co.nz/home/technology/2021/06/review-kobo-elevates-ebook-reader-range-with-expensive-elipsa-bundle.html
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Apple II Manual sold for

$800.000

An Apple II manual signed by

Steve Jobs just sold for nearly

$800,000

By Alaa Elassar, CNN

August 22, 2021

The Apple II manual signed by Steve Jobs and Mike Markkula,

an early investor in Apple.

If you thought Apple computers were expensive, you haven't

seen what their manuals go for.

Boston-based RR Auction on Thursday sold an Apple II manual

signed by the company's late co-founder Steve Jobs for a

whopping $787,484.

The computer's 196-page manual is signed and inscribed

opposite the Table of Contents: "Julian, Your generation is the

first to grow up with computers. Go change the world! steven

jobs, 1980.”

It's also signed by Mike Markkula, an early investor in Apple

and the company's second CEO.

The manual was signed while Jobs and Markkula were in the

United Kingdom promoting Apple, RR Auction said in a

statement announcing the sale. The recipient was Julian

Brewer, the son of an entrepreneur who worked with Apple to

distribute their products in the UK.

"I was sitting in my bedroom writing games on my Apple II

when Dad called me down to meet some guests," Brewer said.

"To my amazement it was Steve Jobs and Mike Markkula. I had

the manual with me and only later understood how rare it was

for Jobs to sign anything, let alone to write an inscription like

this. He got on well with Dad, so I feel the inscription was

made with care."

Launched in 1977, the Apple II was the company's first

successful product and is generally regarded as one of the first

computers made for the mass market. The first computer

spreadsheet, VisiCalc, was written for the Apple II in 1979 and

expanded the computer's popularity to the business market.

The manual detailed the Apple II's technical architecture and

even featured a fold-out schematic of its main logic board.

"Whereas the Apple I was primarily for hobbyists, with less

than 200 units made, the Apple II truly 'changed the world' by

giving around 6 million homes and businesses their first taste

of personal computing. Apple II's revenues supported Apple's

successful floatation, the biggest tech IPO of the time," RR

Auction said.

Jim Irsay, owner of the Indianapolis Colts, placed the winning

bid for the manual.

"When we think of the greatest, most innovative minds of the

past two centuries, Steve Jobs must certainly be included

among them," Irsay said in a statement provided to the auction

house. "Jobs was a truly transformative figure who changed

the way in which human beings think, do business and interact

on a daily basis."

RR Auction also sold other items related to Jobs and Apple,

including a signed letter from Jobs in which he ironically states:

"I'm afraid I don't sign autographs."

It sold for $479,939.�� 

IF YOU THINK THAT
YOU ARE TOO SMALL

TO MAKE A
DIFFERENCE, TRY
SLEEPING WITH A

MOSQUITO.
—Dalai Lama

https://www.rrauction.com/auctions/lot-detail/344697006157001-steve-jobs-inscribed-and-signed-apple-ii-manual/?cat=0
https://www.rrauction.com/auctions/auction-details/615
https://www.rrauction.com/auctions/lot-detail/344176706157003-steve-jobs-typed-letter-signed/?cat=0
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SeniorNet Mac

Guest

Speaker

SeniorNet Mac

Guest

Speaker

NOVEMBER 30thOCTOBER 19th
ABBAS NAZARI,

Fulbright Scholar Masters in Security
Studies, Georgetown University,

Washinton DC.

After The Tampa: From Afghanistan
to New Zealand

When the Taliban were at the height of their power in 2001, Abbas

Nazari's parents were faced with a choice: stay and face persecution

in their homeland, Afghanistan, or seek security for their young

children elsewhere. The family's desperate search for safety took

them on a harrowing journey from the mountains of Afghanistan to a

small fishing boat in the Indian Ocean, crammed with more than 400

other asylum seekers.

When their boat started to sink, they were mercifully saved by a cargo

ship, the Tampa. However, one of the largest maritime rescues in

modern history quickly turned into an international stand-off, as

Australia closed its doors to these asylum seekers. The Tampa had

waded into the middle of a national election, two weeks before the

attacks of September 11, sparking Australia's policy of offshore

detention. While many of those rescued by the Tampa were the first

inmates sent to the island of Nauru, Abbas and his family were some

of the lucky few to be resettled in New Zealand.

Twenty years after the Tampa affair, Abbas tells his extraordinary

story, from living under Taliban rule, to spending a terrifying month at

sea, to building a new life at the bottom of the world. Abbas will have

copies of his book for sale and signature.

Abbas Nazari and his family have thrived since being resettled in New
Zealand. After graduating from the University of Canterbury with a BA
(Hons) in International Relations, Abbas began his career in the New
Zealand public service, with a position at the New Zealand Treasury.
In 2019, Abbas was awarded a Fulbright scholarship to the United
States, where he obtained a Master's in Security Studies from
Georgetown University, Washington DC. Abbas hopes to help children
of refugee backgrounds build meaningful lives in their adopted
homelands. ��

JOSIE ODGEN-SCHROEDER

CEO, YMCA

Josie has lived in Christchurch 30 years since moving here from

Auckland to go to University of Canterbury.

She is married with 3 children and lives near Governors Bay.

Josie is currently the Chief Executive Officer of the Christchurch

YMCA, and has worked for the YMCA fulltime in senior management

positions for 21 years, the past 13 in her current role.

Josie has work experience in youth work, health and fitness and

outdoor education.

She has a Post Graduate Diploma in Not For Profit Management,

a Bachelor of Arts, a Bachelor of Laws, and spent a period of time

serving in the NZ Police.

Her main motivation is to make a difference to the lives of others, and

the great thing about the Y is that the organisation does a lot of

different things for a lot of different people.

The CEO responsibilities are focused on strategic leadership,

guiding the executive management team, and financial sustainability.

Currently, the Y is undertaking a major new development that will set

the Y up for the next 150 years of serving the community. 

“Myths and Legacies, Past and Future?

How is this community agency looking to the future

to support the next
generation of young New Zealanders”
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Tips from across the Ditch—helpful tips for iMac, iPad,
iPhone and Macbook users

courtesy—Pam Doughty,
Editor AUSOM

iPadOS

Markup

Starting with a screenshot or an image within Photos on the

iPad selecting Edit and accessing Markup can result in many

hours of fun for children or adults.

You do need to look at the PDF version of AUSOM News to see

the colours of the part-coloured image. 

Markup Colours

On first glance, Apple's tools provided with Markup and for

Drawing within Notes, Pages, Numbers and Keynote appear to

allow selection of only a limited number of colours.

To change the colour for the selected tool you can tap a preset

colour (the coloured circles near the RH-end).

iPadOS

Notice that one of those circles looks more like a colour wheel

(circled above).

If you tap that you can choose a custom colour.

Once you have chosen a colour you can tap + to save the colour

as a favourite.

To remove a favourite, touch and hold the colour dot then tap

Delete.



Many 'documents' being made available via eMail carry the

reminder 'Please consider the environment before printing...'

macOS

Save As PDF
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With this in mind it SHOULD be easier to save documents as

PDFs.

We all know that when using a Mac is

available near the lower-left of the Print dialog box.

AND

To obtain the Print dialog box most of us remember to Press

Command + P

BUT

At that point we need to take our hands from the

keyboard, locate and tap and then scroll down to

select Save as PDF.

Although Apple has not yet given us a menu item "PRINT TO

PDF" or "SAVE AS PDF" we are able to make the above

procedure quicker and easier by adding a keyboard shortcut to

the above dialog.

To do this go to System Preferences > Keyboard and open the

Shortcuts tab. Scroll down to App Shortcuts and enter 'Save as

PDF' in Menu Title and ⌘ P in Keyboard Shortcut.

Clicking will result in the dialog:

To Save as PDF all you need to do is press Command+P
TWICE.
*NOTE: You should stop after the first Command+P if you don't

want to save ALL the pages)0 

macOS

Creative Mac Folders
If you keep a set of ‘Coloured Folders’ on your Mac you can

‘colour’ any new folder you create to make it easier to identify.

This procedure was discussed at a recent meeting of the Mac

Beginners SIG and a few members haveasked for further

information.

Changing a Folder icon

While in Finder select an existing file or folder that has the icon

of your choice.

• Select File >Get Info.

• Click the icon near the top of the Get Info window.

• Select Edit >Copy

• Close that Get Info window

• Select the file or folder you wish to ‘colour’.

• Select File >Get Info

• Click the icon near the top

• Select Edit >Paste
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Creating coloured folder icons

I copied a plain folder icon from the Get Info window, opened

Preview and selected File > New from Clipboard.

Next I selected Tools > Adjust Color.

One of my coloured folders was created by moving the Tint

slider all the way to the left, another by moving the slider all

the way to the right. Try other sliders—Sepia and Temperature

are good choices—to see what other colours you can obtain.

Yes, I used Preview—the Apple app. It came with your Mac

system and yes, you probably use it most for viewing PDF files.

Adding images to folders

With a folder image open in Preview, go to Pages or
Keynote and look for any shape that appeals to you.

Select it and Copy it to the Clipboard then paste it onto your

Folder in Preview.

You may need to reduce the size of the shape to fit onto the

folder. Do this by moving the tiny dots that will appear around

the shape.

Click away from the shape and select File > Copy.

Now you can Paste your folder with the shape on it onto any

folder within Finder.

Almost anything that you have copied to your clipboard can be

pasted onto the folder icon in the Get Info window. Give it a

try. You really cannot 'break' anything. If you don't like the

result all you have to do is select Get Info, click the folder icon

and press 'delete' on your keyboard. 

iOS

Drag and Drop
Using Slide Over or Split View on your iPad you can view

multiple apps at the same time on the screen. One of my main

reasons to do that is so I can use drag and drop to move objects

between apps.

The Files app

Moving files around is one way to use drag and drop. In Files

using Split View allows me to see more than one location on

the screen.
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• With Files open go to the bottom of the screen.
• Slide up the white bar to show the Dock.
• Select the Files app again and drag it to one side of the

screen.

With the Files app displayed twice I could have ‘On my iPad’

showing on one side of the screen and ‘iCloud Drive’ on the

other side. Now I can drag and drop files between these areas.

Keynote and Photos

With Keynote on one side of my iPad screen and Photos on the

other I can select the photos I want in my Keynote and drag

them ALL onto the sidebar in Keynote. This adds one slide for

each of the photos.

The photos can be moved, cropped or made any size I want.

The following images and description show this.

Make sure Photos is in the Dock. Open a document in Keynote

and drag up from the bottom of the screen to display the Dock.

Drag the Photos icon up and across to the left or right of the

screen.

I have the Photos I want to use in an Album and have displayed

that album in the Photos app on the RH-side of the screen. Tap

one of the photos and move it a short distance from the others.

To select the other photos, keep one finger on the first photo

then tap each of the other photos with another finger. The

photos will jump beneath your first finger.

Drag ALL the photos across the Keynote Window.

You MUST keep your finger on the photos all the time. If you let go

too soon it would be best to start again selecting all the photos.

Keep dragging all the way across the Keynote document and

into the sidebar. When you are beneath the first slide icon in

the sidebar a small vertical line will appear. NOW you can drop

your photos.

If all went well a new 'slide' will be created for each of the

photos.

Placeholder text on the slides can be deleted and individual

photos can be cropped and/or resized.

NOTES:

1. The processes described above are carried out in a very

similar way in macOS.

2. Sometimes copying and pasting is easier than Drag and Drop

because you can’t always see both the origin and destination

for the object on the screen. COPY when you can select the

original object. Then go to another window/app and PASTE. 
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iPadOS

Screenshot on a Mac
First look at the Apple Support Document:

https://support.apple.com/en-au/HT201361

For additional features: With Mojave and later, the Grab app

was replaced with Screenshot app. (Should be located in your

Utilities folder).

See the Apple Support Document: https://support.

apple.com/en-au/guide/mac-help/mh26782/mac

NOTE: The Screenshot app allows you to take screenshots or

recordings of the screen. It also allows you to set a timer to give

you a chance to ensure you are going to capture the correct

information. Plus it allows you to include the pointer or clicks

within the area captured.

The icons above are:

1. Capture the entire screen

2. Capture a window

3. Capture a portion of the screen

4. Record the entire screen

5. Record a portion of the screen 

iPadOS

Quick Tips (iPadOS)

Quick Undo/Redo

Undo/Redo can usually be performed by locating the icon(s)

There are at least 2 other ways to Undo.

• three-finger double tap, or

• three-finger swipe left.

Redo is a three-finger swipe right.

(A handy way to remember Undo is swipe Left is to

look at the way the Undo arrow icon points.)

These methods are worth remembering if you make

use of the floating keyboard.

The floating keyboard is very useful when the larger onscreen

keyboard is covering too much of your screen. It is obtained by

placing two fingers on the keyboard and pinching to shrink it.
(Use two fingers to pinch out to expand the keyboard again).

Scan a Document

This can be performed while using Mail, Files or Notes. (Maybe

other iPad apps too!)
Notes app: Tap the camera icon in the top right

Choose Scan Documents and take a picture of your document.

The iPad can detect the document automatically or you can

adjust manually.

Files app: the scan option is found by tapping the three dots in

the top right of the left-hand sidebar.

Mail app: the scan option will appear ONLY when your cursor is

within the body of the Mail Message.

Quickly Type Symbols and Numbers

Using the onscreen keyboard it is easy to obtain the symbols

and numbers that are shown on the keys.
Swipe down quickly on the corresponding key.
There are additional options accessible by tapping the symbols

key (.?123). The primary punctuation keys are also available at

(.?123) for those who find the swipe down option difficult.

Where is my Pages Document?

Pages, Numbers and Keynote automatically save your

documents. From my experience it depends on the location you

were looking at when you tapped the Create Document +

symbol.
Assuming you have tapped Pages and are ready to create a

new document ...
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If you have On My iPad selected and tap Create Document your

new document will be saved On My iPad and NOT in any of the

folders.

If you have iCloud Drive selected your file will be on iCloud

Drive and not in any folder.

If you have iCloud Drive selected THEN open the Pages folder

THEN Create Document your document will be saved in the

Pages folder on iCloud Drive.

Onscreen keyboard -> trackpad

Touch and hold the Space bar with one finger until the

keyboard turns light grey. (Alternatively place two fingers

anywhere on the keyboard). Move the insertion point by

dragging around the keyboard. 

iPadOS

JPG to PDF tips (iOS)
When collecting information from the Internet, parts of

webpages are often saved by taking screenshots and saving

them to Photos or Files.
You might want to convert these images to a PDF either

individually or combine two or more images into a single PDF.

On an iPad there are a few options available to do this without

the need to purchase any additional apps.

Important Note

Creating PDFs often result in the PDF being opened
in the Books app, making it difficult to share.
While it is open in Books, tapping the screen will
display a share icon with limited options.

Select Print (if this option is available even if you do not have a

printer available).

With two fingers on the image preview, pinch outwards.

This will create a PDF that can be opened in the Book apps.

Option Two: Open in Books

This is easier than option one — if it is available. After

selecting one or more images Books may be offered as an

option within the Share menu — scroll all the way to the right

or you may need to tap More (...) to find it.

Option 3: Using the Files app

Open Files and locate the image or images. To convert a single

image into a PDF: Long press on the image and choose Create

PDF.
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To convert several images into PDF: Tap Select and tap on

multiple images. Tap More.

Choose Create PDF.

The Files app will create a PDF from the images. It will be saved

in the same location as the original images and will have a

similar file name. To save confusion it is advisable to rename or

move the PDF. 

iPadOS

Move an Object
Hold the object with one finger (left hand in diagram). Use

another finger and swipe anywhere to one side in the direction

youwant to move.
You will see the number (circled) change by ONE point for each

swipe. If you swipe with two fingers the object will move by
10 points.

I leave it up to you to try

swiping with three or more

fingers! 

MacOS

Rotate an Object

Select an image or shape; hold down Option+Command and you

can rotate the item around the diagonally opposite point

(2 in the diagram).

The documented method is to hold down Command resulting in

rotation around the centre point (1 in the diagram). 

This 'shortcut' works in current versions of

Pages, Numbers and Keynote.

BUT I cannot find it documented anywhere

so it may not continue to be available.

More

Words from

History

that we need

to bring

back.
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Brian says...
How2

HOW2 Make a Westpac Payment

Paying someone has never been easier. Because now, you can do it all from the one place – regardless of the
type of payment you want to make: one-off payment (guide below), automatic payment, pay multiple
payees, bill payment, credit card payment, payment to Australia or tax payment. You can also transfer
between accounts here. Here’s how it works…

You can pay someone from two places: From the Accounts screen…

—Brian Henderson

continued on next page

http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/automatic-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/pay-multiple-payees/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/pay-multiple-payees/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/bill-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/credit-card-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/overseas-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/tax-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/transfer/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/transfer/


Page 47Helping Seniors with Apple Technology http://seniormac.org.nz

… Or from the Payments screen.

continued on next page

You can pay someone already saved as a payee, or pay someone new.
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You can pay someone already saved as a payee, or pay someone new.

If it’s someone new, this person will automatically be saved as a payee (if they’re in NZ). If you don’t want this,
toggle ‘Off’.

Related How-to's:

Make an automatic payment Make a bill payment

Make a credit card payment Make an Overseas Payment

Pay Multiple Payees Make a tax payment



http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/automatic-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/bill-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/credit-card-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/overseas-payment/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/pay-multiple-payees/
http://www.westpac.co.nz/branch-mobile-online/westpac-one-hub/how-to/tax-payment/

